Upgrading the Cisco ONS 15310-MA SDH to
Release 9.2.1.3
This document explains how to upgrade Cisco ONS 15310-MA SDH Cisco Transport Controller (CTC)
software from Releases 8.5.4 and 9.2.1 to Release 9.2.1.3.
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Before You Begin
Before you begin, write down the following information about your site—date, street address, site phone
number, and dial-up number. This data will be useful during and after the upgrade.

Note

Read the procedures in this document before you begin the upgrade.
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Before You Begin

Caution

This upgrade is supported for Releases 8.5.4 and 9.2.1 upgrading to Release 9.2.1.3. For more
information, see the “Obtaining Documentation and Submitting a Service Request” section on page 20.

Note

R9.2.1.3 supports parallel upgrades for multiple nodes in a network. In a parallel upgrade, you can
activate only one node at a time. However, you can begin activation of the next node as soon as the
controller cards for the current node have rebooted successfully (wait five minutes from the time the
SYSBOOT alarm is raised).

Caution

When managing end-to-end circuits participating in an ML-Series resilient packet ring (RPR) across
multiple nodes involved in a parallel upgrade, all nodes participating in these circuits must have
completed the activation before the end-to-end traffic resumes.

Document Procedures
Procedures in this document must be performed sequentially unless noted otherwise. Ensure that the
procedure is completed for each node in a given network. If you are new to upgrading the
ONS 15310-MA SDH Software, make a printed copy of this document and use it as a checklist.
Each non-trouble procedure (NTP) is a list of steps designed to be accomplished in a specific order.
Follow the steps until the procedure is complete. If you need more detailed instructions, refer to the
detail-level procedure (DLP) specified in the procedure steps. Throughout this guide, NTPs are referred
to as “procedures” and DLPs as “tasks.” Every reference to a procedure includes an NTP number, and
every reference to a task includes a DLP number.
The DLP (task) supplies additional task details to support the NTP. The DLP lists numbered steps that
lead you through completion of a task. Some steps mandate that equipment indications be checked for
verification. When the proper response is not obtained, a trouble clearing reference is provided.
This section lists the document procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).
1.

NTP-U487 Preparing to Upgrade to a New Release, page 3—This section contains critical
information and tasks that you must read and complete before beginning the upgrade process.

2.

NTP-U481 Back Up the ONS 15310-MA SDH Software Database, page 4—Complete the database
backup to ensure that you have preserved your node and network provisioning if you need to restore
them later.

3.

NTP-U512 Upgrade the Cisco ONS 15310-MA SDH Software, page 6—You must complete this
entire procedure before the upgrade is finished.

4.

NTP-U483 Install Public-Key Security Certificate, page 11—You must complete this procedure to
be able to run ONS 15310-MA SDH Software R9.2.1.3.

5.

NTP-U484 Revert to Previous Software Load and Database, page 12—Complete this procedure
only if you have to return to the software load you were running before activating the Software
R9.2.1.3 version.

6.

NTP-U513 Upgrade to the ONS 15310-MA SDH Software Using TL1, page 15—Complete this
procedure only if you want to upgrade to Software R9.2.1.3 using Transaction Language 1 (TL1).
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NTP-U487 Preparing to Upgrade to a New Release
Purpose
Tools/Equipment

This procedure provides critical information checks and tasks you must
complete before starting an upgrade to Release 9.2.1.3.
•

ONS 15310-MA SDH nodes to upgrade

•

PC or UNIX workstation

•

Cisco ONS 15310-MA SDH Software R9.2.1.3

Prerequisite Procedures None
Required/As Needed

Required

Onsite/Remote

Onsite or remote

Security Level

Superuser

Step 1

Read the Release Notes for Cisco ONS 15310-MA SDH Release 9.2.1.

Step 2

Log into the node that you want to upgrade. For detailed instructions, refer to the
Cisco ONS 15310- MA SDH Procedure Guide.

Step 3

Complete the “DLP-U537 Verify CTC Workstation Requirements” task on page 3.

Step 4

When you have completed the tasks in this section, proceed with the “NTP-U481 Back Up the
ONS 15310-MA SDH Software Database” procedure on page 4.
Stop. You have completed this procedure.

DLP-U537 Verify CTC Workstation Requirements
Purpose

This task verifies all PC or UNIX workstation hardware and software
requirements. Before upgrading the workstation to run CTC Software
R9.2.1.3, complete this task.

Tools/Equipment

PC or UNIX workstation

Prerequisite Procedures None

Step 1

Required/As Needed

Required

Onsite/Remote

Onsite or remote (but in the presence of the workstation)

Security Level

Superuser

Ensure that your workstation is one of the following:
•

IBM-compatible PC with a Pentium IV or faster processor, CD-ROM drive, a minimum of 1 GB
RAM and 250 MB of available hard drive space, Windows 2000 Professional (with Service Pack 3),
Windows Server 2003 and 2008, or Windows XP Professional (with Service Pack 1 and 2), Windows
Vista, or Windows 7.

•

UNIX workstation with Solaris Version 9 or 10 on an UltraSPARC-III or faster processor, with a
minimum of 1 GB RAM and a minimum of 250 MB of available hard drive space
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Note

Step 2

Step 3

Step 4

Use the latest patch or service pack released by the OS vendor. Check with the vendor for the latest patch
or service pack.
Ensure that your web browser software is one of the following:
•

Netscape Navigator 7.x or later on Windows

•

Internet Explorer 6.x or later on Windows

•

Mozilla 1.7 or later on Solaris

Verify that the following are installed on your computer:
•

Java Runtime Environment (JRE) 1.6

•

Java Plug-in 1.6

Tip

You can check the JRE version in your browser window by entering the node IP address in the
URL window under Java Version.

Note

For important information about CTC backward compatibility affected by your choice of JRE
version, see the Readme.txt or Readme.html file in the software CD.

Note

To install JRE 1.6, the Java Policy file, or the Software R9.2.1.3 online help, refer to the
installation instructions in the Cisco ONS 15310- MA SDH Procedure Guide.

Return to your originating procedure (NTP).

NTP-U481 Back Up the ONS 15310-MA SDH Software Database
Purpose

This procedure preserves all configuration data of your network before
performing the upgrade.

Tools/Equipment

PC or UNIX workstation

Prerequisite Procedures NTP-U487 Preparing to Upgrade to a New Release, page 3
Required/As Needed

Required

Onsite/Remote

Onsite or remote (but in the presence of the workstation)

Security Level

Maintenance or higher; Superuser, if performing optional Step 8

Step 1

Log into CTC. For detailed instructions, refer to the Cisco ONS 15310- MA SDH Procedure Guide. After
you log in, continue with Step 2.

Step 2

In CTC node view, click the Maintenance tab and then click the Database button.

Step 3

Click the Backup button. A Database Backup dialog box appears.
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Step 4

In the Database Backup dialog box, click the Browse button, then navigate to a local PC directory or
network directory and type or select a database name using the IP address of the node to upgrade (such
as 10101882010107.db).

Step 5

In the Database Backup dialog box, click the OK button. If you are overwriting an existing file, click
Yes in the confirmation dialog box.

Step 6

A message indicates the status of the backup. When the backup is complete, click the OK button to close
the message dialog box.

Step 7

Repeat Steps 1 through 6 for each node in the network.

Step 8

(Optional) Cisco recommends that you manually log critical information by either writing it down or
printing screens where applicable. Use the following table to determine the information you should log.
Complete the table for every node in the network.
Table 1

Manually Recorded Data

Item

Record Applicable Data Here

IP address of the node.
Node name.
Timing settings.
Data communications channel (DCC) connections; list all optical
ports that have DCCs activated.
User IDs; list all, including at least one Superuser.
Inventory; copy the screen contents of the Inventory window. Press
PrintScreen.
Network information; copy the network information from the
Provisioning tab in the network view. Press PrintScreen.
Current configuration (linear, etc.); copy the configuration as
needed.
List all protection groups in the system; copy the protection group
window from the Maintenance tab, in the network view. Press
PrintScreen.
List alarms; copy the screen contents of the Alarm window. Press
PrintScreen.
List circuits; copy the screen contents of the Circuit window. Press
PrintScreen.
Stop. You have completed this procedure.
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NTP-U512 Upgrade the Cisco ONS 15310-MA SDH Software
Purpose

This procedure upgrades your CTC software to R9.2.1.3.

Tools/Equipment

PC or UNIX workstation

Prerequisite Procedures NTP-U481 Back Up the ONS 15310-MA SDH Software Database, page 4

Note

Step 1

Note

Caution

Required/As Needed

Required

Onsite/Remote

Onsite or remote (but in the presence of the workstation)

Security Level

Superuser

After upgrading from R8.5.4 and R9.2.1 to R9.2.1.3, the date and time in CTC is reset.
Insert the Software R9.2.1.3 software CD into the workstation CD-ROM (or otherwise obtain access to
the software) to begin the upgrade process.

Inserting the software CD activates the CTC Setup Wizard.

When managing end-to-end circuits participating in an ML-Series resilient packet ring (RPR) across
multiple nodes involved in a parallel upgrade, all nodes participating in these circuits must have
completed the activation before end-to-end traffic resumes.

Step 2

Complete the “DLP-U582 Download the ONS 15310-MA SDH Software” task on page 7 for all nodes
(or groups of 8 or less nodes) you are upgrading.

Step 3

Complete the “DLP-U583 Activate the New ONS 15310-MA SDH Software” task on page 8 for all
nodes you are upgrading.

Note

Activate one node at a time. You can begin activation of the next node as soon as the controller cards for
the current node have rebooted (wait five minutes from the time the SYSBOOT alarm is raised).

Step 4

(Optional) If you wish to ensure that a software revert to the previous software release will no longer be
possible, complete the “DLP-U582 Download the ONS 15310-MA SDH Software” task on page 7 for
all nodes, or groups of nodes you are upgrading a second time.

Caution

Downloading Software R9.2.1.3 a second time after activation will prevent reversion to the previous
software version.

Step 5

Complete the “DLP-U541 Set the Date and Time” task on page 11 for any nodes not using Simple
Network Time Protocol (SNTP).

Step 6

If you need to return to the software and database you had before activating Software R9.2, proceed with
the “NTP-U484 Revert to Previous Software Load and Database” procedure on page 12.

Step 7

Back up the Software R9.2.1.3 database for the working software load using “NTP-U481 Back Up the
ONS 15310-MA SDH Software Database” procedure on page 4 to preserve the database for Software
R9.2.
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Step 8

(Optional) Upgrade the field-programmable gate array (FPGA) on CTX2500 cards for all nodes or
groups of nodes to eliminate unwanted data coming in the UDC Rx path. An upgrade to 1D ensures that
FPGA only processes clear data.

Caution

Upgrading the FPGA can be service affecting, so Cisco recommends that you activate the new load in a
maintenance window. ML-Series Ethernet traffic, time-division multiplexing (TDM) traffic, and
CE-Series Ethernet traffic can remain down from the time the CTX2500 cards switch to the time all
Ethernet and TDM cards have finished resetting (3 to 8 minutes).

To upgrade the FPGA do the following:
a. In node view, click Provisioning > FPGA Update tabs.
b. Click the Force FPGA Update button.

The active CTX2500 card reboots and restarts the updated FPGA. Once the active CTX2500
comes up, the peer CTX2500 card reboots. The FPGA is updated in the peer CTX2500 card as
well. The new FPGA revision number is visible on the active CTX2500.

Note

Update the FPGA during a scheduled maintenance window.

Stop. You have completed this procedure.

DLP-U582 Download the ONS 15310-MA SDH Software
Purpose

This task downloads Software R9.2.1.3 to the ONS 15310-MA SDH nodes
prior to activation.

Tools/Equipment

PC or UNIX workstation

Prerequisite Procedures NTP-U481 Back Up the ONS 15310-MA SDH Software Database, page 4

Note

Required/As Needed

Required

Onsite/Remote

Onsite or remote (but in the presence of the workstation)

Security Level

Superuser or Maintenance

The CTX2500 card has two flash RAMs. An upgrade downloads the software to the backup RAM on the
CTX2500 card. The download task does not affect traffic because the active software continues to run at
the primary RAM location; therefore, you can download the software at any time.

Step 1

If CTC is not already running, start CTC, using the IP address of the ONS 15310-MA SDH node.

Step 2

In CTC node view, click the Alarms tab.

Step 3

Verify that the alarm filter is not on.
a.

Click the Filter button at the lower-left of the window.
The Alarm Filter dialog box appears.

b.

Click to select any check box that is not selected in the Show Severity section of the General tab.
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Step 4

On the Alarms tab, check all nodes for existing alarms. Resolve any outstanding critical alarms before
proceeding.

Note

During the software download process, the SWFTDWN alarm is raised twice, once on standby and again
on active, to indicate that the software download is taking place. The alarm is normal and clears when
the download is complete.

Note

To download and upgrade the software using TL1, see the “NTP-U513 Upgrade to the ONS 15310-MA
SDH Software Using TL1” procedure on page 15.

Step 5

If the display is not in node view, double-click the node icon to return to node view.

Step 6

Click the Maintenance tab and then click the Software button.

Step 7

Click the Download button. The Download Selection dialog box appears.

Step 8

Click the Browse button to locate the software files on the ONS 15310-MA SDH software CD or on your
hard drive, if you are working from a local copy.

Step 9

Open the Cisco 15310-MA SDH folder, choose the file with the PKG extension and click Open.

Step 10

In the list of compatible nodes, click the check boxes for all nodes for software download.

Note

Cisco advises that you limit concurrent software downloads on a Section data communications channel
(SDCC) to eight nodes at once, using the central node to complete the download.

Note

If you attempt more than eight concurrent software downloads at once, all those downloads in excess of
eight are placed in a queue.

Step 11

Note
Step 12

Click OK. The Download Status column monitors the progress of the download.

The software download process can take up to 30 minutes per node, though typically under ten minutes.
Return to your originating procedure (NTP).

DLP-U583 Activate the New ONS 15310-MA SDH Software
Purpose

This task activates Software R9.2.1.3 in each node in the network.

Tools/Equipment

PC or UNIX workstation

Prerequisite Procedures DLP-U582 Download the ONS 15310-MA SDH Software, page 7
Required/As Needed

Required

Onsite/Remote

Onsite or remote (but in the presence of the workstation)

Security Level

Superuser
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Caution

Note

Activation can be service affecting, so Cisco recommends that you activate the new load in a
maintenance window. ML-Series Ethernet traffic can remain down from the time the CTX2500 cards
switch to the time all Ethernet cards have finished resetting (3 to 8 minutes). However time-division
multiplexing (TDM) traffic and CE-Series Ethernet traffic should remain errorless.

If you do not plan to run the pre-caching utility, Cisco recommends that the first node you activate be a
LAN-connected node. This ensures that the new CTC JAR files download to your workstation as quickly
as possible.

Step 1

If CTC is not already running, start CTC, using the IP address of the ONS 15310-MA SDH node.

Step 2

Record the IP address of the node. The IP address is on the upper left corner of the CTC window.

Step 3

Verify that the alarm filter is not on.
a.

Click the Filter tool at the lower-left of the window.
The Alarm Filter dialog box appears.

b.

Click to deselect any selections in the Show Severity section of the General tab.

Step 4

On the Alarms tab, check all nodes for existing alarms. Resolve any outstanding critical alarms before
proceeding.

Step 5

Click the Maintenance tab and then click the Software button.

Step 6

Verify that the version in the Protect Version column is Software R9.2.1.3.

Step 7

Click the Activate button. Click Yes to proceed with the activation.

Step 8

Click Yes to proceed with the activation. An Activation Successful message indicates that the software
is successfully activated. Click OK in the message dialog box.
When you click Yes the activation begins, and the software upgrade reboot occurs as follows:
•

Each card in the node resets, beginning with the standby CTX2500 card. When the standby
CTX2500 finishes rebooting, the two CTX2500 cards switch and CTC temporarily loses connection
with the node. (The connection is restored after the switch is established, within 4 minutes of the
connection loss.)

•

Next, the standby (previously active) CTX2500 reboots, along with the electrical and Ethernet cards.
They reboot from left to right.

•

A system reboot (SYSBOOT) alarm is raised while activation is in progress (following the CTX2500
and cross-connect card resets). When all cards have reset, this alarm clears. The complete activation
process can take up to 30 minutes, depending on how many cards are installed.

•

The whole process can take up to 10 minutes. This process is errorless for TDM and CE-series
traffic. ML-Series cards are expected to incur a traffic hit of 3 to 8 minutes.

After the common control cards finish resetting and all associated alarms clear, you can safely proceed
to the next step. (If you are upgrading remotely and cannot see the nodes, wait for 5 minutes for the
process to complete, then check to ensure that related alarms have cleared before proceeding.)

Note

During the software upgrade, a reset alarm is raised on all the cards. When upgrading from 8.5.4 and
9.2.1 to 9.2.1.3 an AUTORESET alarm is raised on Standby CTX2500 cards and all the other cards.
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Step 9

Note

In CTC, choose File > Exit.

Steps 10 through 12 are only necessary after upgrading the first node in a network because cached files
only need to be removed from your workstation once. For the remaining nodes, you will still be
disconnected and removed to the network view during the node reboot, but after the reboot is complete,
CTC will restore connectivity to the node.

Step 10

A message indicating the CTC software release version and detection of a R9.2.1.3 network element
appears. You must download and install R9.2.1.3 CTC jar files on your computer.

Step 11

To do so, select Update CTC from the Tools menu.

Step 12

After the CTC Java Jar files are successfully downloaded, close CTC and reopen.

DLP-U540 Delete Cached JAR Files
Purpose

This task manually deletes cached Java JAR files from your browser and
hard drive. When you upgrade or revert to a different CTC software load,
you must reload CTC to your browser. Before you can reload CTC, you
must ensure that previously cached files are cleared from your browser
and hard drive.

Tools/Equipment

PC or UNIX workstation

Prerequisite Procedures None

Step 1

Required/As Needed

As needed

Onsite/Remote

Onsite or remote (but in the presence of the workstation)

Security Level

Maintenance or higher

Delete cache files from your browser directory.
In Netscape:
a.

Choose Edit > Preferences, click the Advanced tab, then click the Cache button.

b.

Click the Clear Memory Cache button, and click OK.

c.

Click the Clear Disk Cache button, and click OK twice.

In Microsoft Internet Explorer:

Step 2

a.

Choose Tools > Internet Options. The Internet Options dialog box appears.

b.

Click the General tab, and then click the Delete Files button.

c.

Click the Delete all offline content check box.

d.

Click OK twice.

Close your browser.

Note

You cannot delete cached JAR files from your hard drive until you have closed your browser. If
you have other applications open that use JAR files, you must also close them.
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Step 3

On Windows systems, delete cached files from your workstation in the following location:
C:\Documents and Settings\username\Application Data\Cisco\CTC.

Step 4

Reopen your browser. You should now be able to connect to CTC.

Step 5

Return to your originating procedure (NTP).

DLP-U541 Set the Date and Time
Purpose

If you are not using SNTP, the upgrade procedure can cause the date/time
setting to change. This task resets the date and time for each node.

Tools/Equipment

PC or UNIX workstation

Prerequisite Procedures None

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote (but in the presence of the workstation)

Security Level

Superuser

This task is not applicable if you are using SNTP.

Step 1

If CTC is not already running, start CTC, using the IP address of the ONS 15310-MA SDH node.

Step 2

In CTC node view, click the Provisioning tab and then click the General button.

Step 3

Set the correct date and time, then click the Apply button.

Step 4

Repeat Steps 1 and 3 for each remaining node.

Step 5

Return to your originating procedure (NTP).

NTP-U483 Install Public-Key Security Certificate
Purpose

This procedure installs the ITU Recommendation X.509 public-key
security certificate. The public-key certificate is required to run
Software R4.1 or later.

Tools/Equipment

None

Prerequisite Procedures This procedure is performed when logging into CTC. You cannot perform
it at any other time.

Step 1

Required/As Needed

This procedure is required to run ONS 15310-MA SDH software.

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Log into CTC.
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Step 2

If the Java Plug-in Security Warning dialog box appears, choose one of the following options:
•

Grant This Session—Installs the public-key certificate to your PC only for the current session. When
the session ends, the certificate is deleted. This dialog box appears the next time you log into the
ONS 15310-MA SDH.

•

Deny—Denies permission to install the certificate. If you choose this option, you cannot log into the
ONS 15310-MA SDH.

•

Grant always—Installs the public-key certificate and does not delete it even after the session is over.
Cisco recommends this option.

•

View Certificate—Allows you to view the public-key security certificate.

After you complete the security certificate dialog boxes, the web browser displays information about
your Java and system environments. If this is the first time you are logging in, a CTC downloading
message appears while CTC files are downloaded to your computer and this process can take several
minutes. After the download, the CTC Login dialog box displays.
Step 3

If you need to return to the software and database you had before activating Software R9.2.1.3, proceed
with the “NTP-U484 Revert to Previous Software Load and Database” procedure on page 12.
Stop. You have completed this procedure.

NTP-U484 Revert to Previous Software Load and Database
Purpose

This procedure restores the software and database provisioning you had
before you activated Software R9.2.1.3.

Tools/Equipment

PC or UNIX workstation

Prerequisite Procedures NTP-U487 Preparing to Upgrade to a New Release, page 3
NTP-U481 Back Up the ONS 15310-MA SDH Software Database, page 4
NTP-U512 Upgrade the Cisco ONS 15310-MA SDH Software, page 6
Required/As Needed

As needed

Onsite/Remote

Onsite or remote (but in the presence of the workstation)

Security Level

Superuser

Note

The tasks to revert to a previous load are not part of the upgrade. If you have performed all the necessary
procedures up to this point, you have completed the software upgrade to R9.2.1.3.

Note

The defaults database files (db files) used to restore the basic configuration on a single non-multishelf
node are shipped along with the standard R9.2.1.3 software release package. For a multishelf set-up, the
multishelf configuration must be unprovisioned to restore the basic configuration using the defaults
database file. Also, the database backup from a multishelf system can be used to restore the same
multishelf system.
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Note

Before you upgraded to Software R9.2.1.3, you should have backed up the existing database on all the
nodes in the network (this is part of the “NTP-U481 Back Up the ONS 15310-MA SDH Software
Database” procedure on page 4). Cisco recommends that you record or export all critical information to
your hard drive. If you need to revert to the backup database, use the following tasks, in order.

Step 1

Log into the node. For detailed instructions, refer to the Cisco ONS 15310- MA SDH Procedure Guide.
If you are already logged in, continue with Step 2.

Step 2

Complete the “DLP-U542 Revert to Protect Load” task on page 13.

Caution

Step 3

Do not perform “DLP-U543 Manually Restore the Database” task on page 14 unless the software revert
failed.
If the software revert to a previous release failed to restore the database, complete the “DLP-U543
Manually Restore the Database” task on page 14.
Stop. You have completed this procedure.

DLP-U542 Revert to Protect Load
Purpose

This task reverts to the software you were running prior to the last
activation and restores the database to the provisioning prior to the
activation.

Tools/Equipment

PC or UNIX workstation

Prerequisite Procedures NTP-U487 Preparing to Upgrade to a New Release, page 3
NTP-U481 Back Up the ONS 15310-MA SDH Software Database, page 4
NTP-U512 Upgrade the Cisco ONS 15310-MA SDH Software, page 6

Note

Required/As Needed

Required for revert

Onsite/Remote

Onsite or remote (but in the presence of the workstation)

Security Level

Superuser

To perform a supported (non-service-affecting) revert from Software R9.2.1.3, the release you want to
revert to must have been working at the time you activated to Software R9.2.1.3 on that node. Also, a
supported revert automatically restores the node configuration at the time of the previous activation. Any
configuration changes made after activation will be lost when you revert the software. The exception to
this is when you have downloaded Software R9.2.1.3 a second time, to ensure that no actual revert to a
previous load can take place. In this latter case, the revert occurs, but the traffic is not affected and there
are no changes to the database.

Step 1

If CTC is not already running, start CTC, using the IP address of the ONS 15310-MA SDH node.

Step 2

From the CTC node view, click the Maintenance tab and then click the Software button.

Step 3

Verify that the protect software is the release you upgraded from.
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Step 4

Click the Revert button to activate the protect software and to restore the database from the previous
load. A dialog box asks you to confirm the choice.

Step 5

Click Yes. This begins the revert. CTC drops the connection to the node and takes you to the network
view, displaying a confirmation dialog box.

Step 6

Click OK and wait until the software revert finishes before continuing.

Note

The system reboot might take up to 10 minutes to complete.

Step 7

Wait one minute before reverting another node.

Step 8

After reverting all the nodes in the network, close and restart your Netscape or Internet Explorer browser
and log back into the last node that was reverted. This uploads the appropriate CTC applet to your
workstation.

Note

Step 9

It is necessary to delete cached files from your browser’s directory or from the TEMP directory
on your Microsoft Windows workstation. If you have trouble reconnecting to CTC, see the
“DLP-U540 Delete Cached JAR Files” task on page 10.

Return to your originating procedure (NTP).

DLP-U543 Manually Restore the Database
Purpose

This task manually restores the database. If you were unable to perform a
revert successfully and need to restore the database, perform this task.

Tools/Equipment

PC or UNIX workstation

Prerequisite Procedures DLP-U542 Revert to Protect Load, page 13
Required/As Needed

As needed

Onsite/Remote

Onsite or remote (but in the presence of the workstation)

Security Level

Superuser

Caution

Do not perform these steps unless the software revert failed.

Caution

This process is service affecting and should be performed during a maintenance window.

Step 1

If CTC is not already running, start CTC, using the IP address of the ONS 15310-MA SDH node.

Step 2

In the CTC node view, Click the Maintenance tab and then click the Database button.

Step 3

Click the Restore button. The Restore Database dialog box appears.

Step 4

Select the previously saved database file and choose Open.
The database is restored and the CTX2500 cards reboots.

Step 5

When the CTX2500 cards have rebooted, log back into CTC and verify that the database is restored.
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Wait one minute before restoring the next node.
Step 6

You have now completed the manual database restore.

Note

Step 7

When the complete database is restored, the node does not report an event regarding the IP
change; the node reboots and configures the new IP from the database. If the IP address being
restored is not in the CTC network IP addressing scheme, you might lose visibility of the node.
To resolve this, you must launch CTC with the IP mentioned in the table against the database
backup. Refer to Table 1 “Manually Recorded Data” in the “NTP-U481 Back Up the
ONS 15310-MA SDH Software Database” procedure on page 4 for more information.

Return to your originating procedure (NTP).

NTP-U513 Upgrade to the ONS 15310-MA SDH Software Using
TL1
Purpose

This procedure upgrades the software to R9.2.1.3 using TL1 rather than
CTC.

Tools/Equipment

PC or UNIX workstation

Prerequisite Procedures NTP-U487 Preparing to Upgrade to a New Release, page 3
NTP-U481 Back Up the ONS 15310-MA SDH Software Database,
page 4

Note

Required/As Needed

Optional

Onsite/Remote

Onsite or remote (but in the presence of the workstation)

Security Level

Superuser

This procedure assumes you are upgrading using Release 6.x TL1 syntax. TL1 commands issued prior
to software activation to Software R9.2.1.3 varies in syntax depending on the release you are actually
upgrading from. To ensure that your syntax for each command is correct, use the TL1 syntax supplied
in the Cisco ONS 15454 SDH, Cisco ONS 15600 SDH, and Cisco ONS 15310-MA SDH TL1 Command
Guide for your particular release when issuing the following commands:
•

ACT-USER

•

COPY-RFILE

•

REPT-EVT-FXFR

•

OPR-PROTNSW-<OCN_TYPE>

•

RTRV-COND-ALL

•

RTRV-ALM-ALL
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Note

To perform an R9.2.1.3 software download using TL1, you must first have an FTP server or a terminal
emulation program like HyperTerminal running on your workstation. The download (COPY-RFILE)
command is different when downloading software to a gateway network element (GNE) or an end
network element (ENE) under the following conditions:
•

FTP is being used.

•

Server is set up with a login and password of FTPUSER1 and FTPUSERPASSWORD1.

•

FTP server has an IP address of 10.1.1.1.

•

FTP server is running on the standard FTP port.

•

Software package is called “15310masdh-03xx-A04K-1405.pkg”.

The GNE and ENE commands are as follows:
•

When downloading software to a GNE, use the following command:
COPY-RFILE:NODENAME:RFILE-PKG:CTAG::TYPE=SWDL,
SRC=“ftp://FTPUSER1:FTPUSERPASSWORD1@10.1.1.1/15310-03xx-A04K-1405.pkg”;

•

When downloading software to an ENE, use the following command:
COPY-RFILE:NODENAME:RFILE-PKG:CTAG::TYPE=SWDL,
SRC=“ftp://FTPUSER1:FTPUSERPASSWORD1@10.111.11.1:21@90.90.90.90/15310-03xx-A04K-1405.p
kg”;

The ":21" after the FTP server IP address 10.111.11.1 denotes port 21 on the server.
The software PKG file in the preceding example is located in the home directory of the FTP server.
If the software PKG file is not in the home directory on the FTP server, insert the directory path
where the software package resides between the last IP address and the PKG file in the command
line. An example is shown here:
COPY-RFILE:NODENAME:RFILE-PKG:CTAG::TYPE=SWDL,
SRC=“ftp://FTPUSER1:FTPUSERPASSWORD1@10.1.1.1:21@90.90.90.90/CISCO/SOFTWARE/15310-03xx
-A04K-1405.pkg”;

Step 1

To use TL1 commands, set up an FTP session or use HyperTerminal or a similar terminal emulation
package to establish a session with the ONS 15310-MA SDH node.

Step 2

Type the IP address for the node, using port 3083 or 2361.
The terminal emulation interface displays a warning message and a command prompt (usually >).
Execute the TL1 commands at this prompt.

Step 3

Type the ACT-USER (Activate User) command in the TL1 request window to open a TL1 session:
ACT-USER:[<TID>]:<uid>:<CTAG>[::<pid>];

where:
•

<TID> is the target identifier (optional).

•

<uid> is the optical support system Operations Support System (OSS) profile user ID (required).

•

<CTAG> is the correlation tag that correlates command and response messages (optional).

•

<pid> is the password identifier (required).

For example, in the TL1 command:
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ACT-USER::CISCO99:100::PASSWORD;

ACT-USER is the activation command, CISCO99 is the user ID, 100 is the correlation tag (used to
correlate commands to command responses), and PASSWORD is the password associated with the
user ID.
A response message containing the CTAG that you specified indicates the completion status of the
command.
Step 4

Select the IP address for the node, using port 3083 or 2361.

Step 5

Type the COPY-RFILE command in the TL1 window. If you are using HyperTerminal, select
Transfer > Receive File, and use the associated dialog box to select a file to receive. The COPY-RFILE
command downloads a new software package from the location specified by the FTP URL into the
inactive flash partition residing on either of the CTX2500 cards.
COPY-RFILE:[<TID>]:<src>:<CTAG>::TYPE=<xfertype>,[SRC=<src1>],[DEST=<dest>],[OVWRT=<ovwrt>
],[FTTD=<fttd>];

where:
•

<TID> is the target identifier (optional).

•

<src> is the source AID (required).

•

<CTAG> is the correlation tag that correlates command and response messages (optional).

•

<xfertype> is the file transfer protocol (required).

•

<src1> specifies the source of the file to be transferred (required).

•

<dest> is the destination of the file to be transferred (required).

•

<ovwrt> is overwrite. If <OVWRT> is yes, then files should be overwritten. If <OVWRT> is no,
then file transfers will fail if the file already exists at the destination (required).

•

<fttd> is the URL format (required).

Step 6

Repeat Step 5 for all nodes to be upgraded.

Step 7

Look for the REPT-EVT-FXFR message in the TL1 window. REPT-EVT-FXFR is an autonomous
message used to report the start, completion, and completed percentage status of the software download.
REPT-EVT-FXFR also reports any failure during the software upgrade, including invalid package,
invalid path, invalid userid/password, and loss of network connection.
The format of the message is:
REPT EVT FXFR

A

SID DATE TIME
ATAG REPT EVT FXFR
"<FILENAME>,<FXFR_STATUS>,[<FXFR_RSLT>],[<BYTES_XFRD>]"

;

where:

Step 8

•

<FILENAME> indicates the transferred file path name and is a string.

•

<FXFR_STATUS> indicates the file transferred status: Start, IP (in progress), or COMPLD.

•

<FXFR_RSLT> indicates the file transferred result: success or failure. FXFR_RSLT is optional (the
FXFR_RSLT is only sent when the FXFR_STATUS is COMPLD).

•

<BYTES_XFRD> indicates the percentage transfer complete and is optional (the BYTES_XFRD is
only sent when the FXFR_STATUS is IP or COMPLD).

Complete NTP-U487 Preparing to Upgrade to a New Release, page 3 for each node to be upgraded.
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Step 9

Complete NTP-U481 Back Up the ONS 15310-MA SDH Software Database, page 4 for each node to be
upgraded.

Step 10

Verify that there are no outstanding alarms or conditions on each node using the following commands:
RTRV-COND-ALL:[<TID>]:[<AID>]:<CTAG>::[<TYPEREQ>][,,,];

where:
•

<TID> is the target identifier (optional).

•

<AID> indicates the entity in the node. <AID> must not be null.

•

<CTAG> is the correlation tag that correlates command and response messages (optional).

•

<TYPEREQ> is the type of condition to be retrieved. A null value is equivalent to ALL.

RTRV-ALM-ALL:[<TID>]:[<AID>]:<CTAG>::[<NTFCNCDE>],[<CONDITION>],[<SRVEFF>][,,,];

where:
•

<TID> is the target identifier (optional).

•

<AID> indicates the entity in the node. <AID> must not be null.

•

<CTAG> is the correlation tag that correlates command and response messages (optional).

•

<NTFCNCDE> is a notification code. A null value is equivalent to ALL.

•

<CONDITION> is the type of alarm condition. A null value is equivalent to ALL.

•

<SRVEFF> is the effect on service caused by the alarm condition. A null value is equivalent to ALL.

Resolve all issues before proceeding.

You can only activate one node at a time. However, in a parallel upgrade, you can begin
activation of the next node as soon as the controller cards for the current node have rebooted
successfully. If you wish to perform a parallel upgrade remotely, wait five minutes for the
controller cards to complete the reboot.

Note

Step 11

Starting at the node farthest from the GNE, type the APPLY command to activate the system software.
APPLY:[<TID>]::<CTAG>[::<MEM_SW_TYPE>];

where:
•

<TID> is the target identifier.

•

<CTAG> is the correlation tag that correlates command and response messages.

•

<MEM_SW_TYPE> indicates a memory switch action during the software upgrade.
MEM_SW_TYPE is ACT for activate.

If the command is successful, the appropriate flash is selected and the CTX2500 card reboots.
The following occurs:
•

Each card in the node reboots, beginning with the standby CTX2500 card. When the standby
CTX2500 card reboots, it signals the active CTX2500 card that it is ready to take over. When the
active CTX2500 receives this signal, it resets itself, and the standby CTX2500 takes over and
transitions to active. The pre-upgrade version of the CTX2500 card is now the standby CTX2500.

•

Next, the E-Series Ethernet cards reset simultaneously.

•

Any cards in Y-cable protection groups boot next, one at a time (protect card first), in order of first
creation (refer to the CTC protection group list for order of first creation).
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•

Next, the traffic cards, G-Series Ethernet cards, CE-Series Ethernet cards, and ML-Series Ethernet
cards boot consecutively, in ascending order of slot number, first standby, then working, for each
card pair.

•

A system reboot (SYSBOOT) alarm is raised while activation is in progress (following the CTX2500
and cross-connect card resets). When all cards have reset, this alarm clears. The complete activation
process can take up to 30 minutes, depending on how many cards are installed.

After the common control cards finish resetting and all associated alarms clear, you can safely proceed
to the next step. (If you are upgrading remotely and cannot see the nodes, wait for 5 minutes for the
process to complete, then check to ensure that related alarms have cleared before proceeding.)
Step 12

Perform Step 11 for each node that will be upgraded, moving from the furthest node from the GNE
toward the GNE itself, which should be activated last.

Note

Step 13

You might have to log in (Step 1 and Step 3) to each node again to activate the software
(Step 11).

After all nodes have been activated, log in using CTC or Telnet (Step 1 and Step 3) and verify there are
no outstanding alarms.
Stop. You have completed this procedure.

Related Documentation
•

Release Notes for Cisco ONS 15310-MA SDH, Release 9.2.1.3

•

Cisco ONS 15310- MA SDH Procedure Guide

•

Cisco ONS 15310-MA SDH Reference Manual

•

Cisco ONS 15310-MA SDH Troubleshooting Guide

•

Cisco ONS 15310-MA SDH Ethernet Card Software Feature and Configuration Guide

•

Cisco ONS 15454 SDH, Cisco ONS 15600 SDH, and Cisco ONS 15310-MA SDH TL1 Command
Guide

•

Cisco ONS 15454 SDH, Cisco ONS 15600 SDH, and Cisco ONS 15310-MA SDH TL1 Reference
Guide

Obtaining Optical Networking Information
This section contains information that is specific to optical networking products. For information that
pertains to all of Cisco, refer to the Obtaining Documentation and Submitting a Service Request section.
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Where to Find Safety and Warning Information
For safety and warning information, refer to the Cisco Optical Transport Products Safety and
Compliance Information document that accompanied the product. This publication describes the
international agency compliance and safety information for the Cisco ONS 15454 system. It also
includes translations of the safety warnings that appear in the ONS 15454 system documentation.

Cisco Optical Networking Product Documentation CD-ROM
Optical networking-related documentation, including Cisco ONS 15xxx product documentation, is
available in a CD-ROM package that ships with your product. The Optical Networking Product
Documentation CD-ROM is updated periodically and may be more current than printed documentation.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What's New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at:
http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
Subscribe to the What's New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a
free service and Cisco currently supports RSS version 2.0.
This document is to be used in conjunction with the documents listed in the “Related Documentation” section.
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